Working Capital and Cash Flow Analysis

Cash is the most liquid of all assets, so many managers are particularly interested in how much cash is available to a business at any given time. Because the flow of cash into and out of a business is mainly a matter of investing (purchasing assets) and disinvesting (disposing of assets), an analysis of cash flows can help measure management’s performance.

This chapter describes the process of accounting for and analyzing cash flows. Although it doesn’t replace them, the cash flow statement is a useful adjunct to income statements and balance sheets. Using tools that are available to you in the form of different functions and links, you’ll see how to use Excel to convert the information in a balance sheet and income statement to a cash flow statement.

To set the stage, the next section discusses how costs are timed.

Matching Costs and Revenues

Several other chapters of this book mention the matching principle—the notion that revenue should be matched with whatever expenses or assets produce that revenue.

This notion leads inevitably to the accrual method of accounting. If you obtain the annual registration for a truck in January and use that truck to deliver products to your customers for 12 months, you have paid for an item in January that helps you produce revenue all year long.

If you record the entire amount of the expense in January, you overstate your costs and understate your profitability for that month. You also understate your costs and overstate your profitability for the remaining 11 months.
Largely for this reason, the accrual method evolved. Using the accrual method, you would accrue 1/12th of the expense of the truck registration during each month of the year. Doing so enables you to measure your expenses against your revenues more accurately throughout the year.

Similarly, suppose that you sell a product to a customer on a credit basis. You might receive periodic payments for the product over several months, or you might receive payment in a lump sum sometime after the sale. Again, if you wait to record that income until you have received full payment, you will misestimate your profit until the customer finishes paying you.

Some very small businesses—primarily sole proprietorships—use an alternative to accrual, called the *cash method* of accounting. They find it more convenient to record expenses and revenues when the transaction took place. In very small businesses, the additional accuracy of the accrual method might not be worth the effort. An accrual basis is more complicated than a cash basis and requires more effort to maintain, but it is often a more accurate method for reporting purposes.

The main distinction between the two methods is that if you distribute the recording of revenues and expenses over the full time period when you earned and made use of them, you are using the accrual method. If you record their totals during the time period that you received or made payment, you are using the cash method. As an example of the cash method of accounting, consider Figure 5.1.

Figure 5.1
The cash basis understates income when costs are not associated with revenue that they help generate.

Suppose that Jean Marble starts a new firm, Marble Designs, in January. At the end of the first month of operations, she has made $10,000 in sales and paid various operating expenses: her salary, the office lease, phone costs, office supplies, and a computer. She was able to save 20% of the cost of office supplies by making a bulk purchase that she estimates will last the entire year. Recording all of these as expenses during the current period results in net income for the month of $1,554.

Contrast this result with Figure 5.2.
Using the accrual method, Marble Designs records 1/12th of the cost of the office supplies during January. This is a reasonable decision because they are expected to last a full year. It also records 1/36th of the cost of the computer as depreciation. The assumption is that the computer’s useful life is three years and that its eventual salvage or residual value will be zero. The net income for January is now $5,283, which is 3.4 times the net income recorded under the cash basis.

The net income of $5,283 is a much more realistic estimate for January than $1,554. Both the office supplies and the computer will contribute to the creation of revenue for much longer than one month. In contrast, the benefits of the salary, lease, and phone expenses pertain to that month only, so it is appropriate to record the entire expense for January.

But this analysis says nothing about how much cash Marble Designs has in the bank. Suppose that the company must pay off a major loan in the near future. The income statement does not necessarily show whether Marble Designs will likely be able to make that payment.

**Figure 5.2**
Marble Designs’ income statement: The accrual basis more accurately estimates income.

Using the accrual method, Marble Designs records 1/12th of the cost of the office supplies during January. This is a reasonable decision because they are expected to last a full year. It also records 1/36th of the cost of the computer as depreciation. The assumption is that the computer’s useful life is three years and that its eventual salvage or residual value will be zero. The net income for January is now $5,283, which is 3.4 times the net income recorded under the cash basis.

The net income of $5,283 is a much more realistic estimate for January than $1,554. Both the office supplies and the computer will contribute to the creation of revenue for much longer than one month. In contrast, the benefits of the salary, lease, and phone expenses pertain to that month only, so it is appropriate to record the entire expense for January.

But this analysis says nothing about how much cash Marble Designs has in the bank. Suppose that the company must pay off a major loan in the near future. The income statement does not necessarily show whether Marble Designs will likely be able to make that payment.

**Broadening the Definition: Cash vs. Working Capital**

So far, we have discussed funds in terms of cash only. A broader and more useful way of looking at the availability of funds involves the concept of *working capital*.

How does your company create income? If you manufacture a product, you use funds to purchase inventory, produce goods with that inventory, convert those goods into accounts receivable by selling them, and convert accounts receivable into cash when you take payment. If you are a merchandising firm, the process is basically the same, although you probably purchase finished goods instead of producing them.

Each of the components in this process is a current asset, such as an asset that you can convert into cash in a relatively short period (usually, but not always, one year) as a result of your normal business operations. Inventory and accounts receivable, for example, are not as liquid as cash, but your business expects to convert both to cash before too long.

Current liabilities, on the other hand, are obligations that you must meet during the same relatively short time period that defines your current assets. Notes payable, accounts payable, and salaries are examples of current liabilities.
Determining the Amount of Working Capital

*Working capital* is the result of subtracting current liabilities from current assets. It is a measure of a company’s solvency, its capacity to make large purchases and take advantage of bulk discounts, and its ability to attract customers by offering advantageous credit terms.

**CASE STUDY**

**Marble Designs’ Working Capital**

To complicate the activities of Marble Designs in January 2007 with one additional transaction, assume that the company purchases $2,000 worth of inventory on January 1. The inventory is purchased on credit, and Marble Designs uses $500 of the inventory during January to deliver products to customers.

**Accounting for the Cash Transactions**

Figure 5.3 shows the cash transactions that occur during January. Because they are all cash transactions, they don’t include the inventory purchased on credit.

Jean Marble establishes capital for her new firm by investing $9,000 at the outset. Of the $10,000 in sales that she makes during the first month, she receives cash payment of $2,000: Her cash account is now $11,000. Out of that $11,000, she makes cash payment for the following:

- $3,500 for her salary
- $900 for the monthly office lease
- $96 for the telephone line
- $2,000 for office supplies
- $1,950 for a computer

**Getting an Adjusted Trial Balance**

These transactions are shown in a format that helps Marble move to a trial balance and then to an adjusted trial balance (see Figure 5.4), and subsequently to an income statement and balance sheet.
Broadening the Definition: Cash vs. Working Capital

On the left (or debit) side of the trial balance are the ending cash balance of $2,554, the accounts receivable of $8,000 (recall that sales of $10,000 were made and $2,000 in cash payments were received), the inventory purchased with the $2,000 loan, and the office supplies, computer, salary, lease, and telephone service paid for with cash.

On the right, or credit, side of the trial balance are Marble's initial capital investments into Cash, the $10,000 in sales, and the $2,000 borrowed to purchase the inventory.

The adjustments to the trial balance include $54.17 in depreciation on the computer during the first of 36 months of its useful life, and the $166.67 worth of supplies prorated during the first month. The $54.17 in depreciation is found with this formula:

\[ \text{SLN}(B8,0,36) \]

SLN( ) is the Excel function that returns straight-line depreciation. You will learn more about Excel’s depreciation functions in Chapter 16, “Fixed Assets.” This particular entry computes the monthly depreciation on the value in cell B8 ($1,950), assuming that its eventual salvage value will be $0 and that its useful life is 36 months.

On the left (or debit) side of the trial balance are the ending cash balance of $2,554, the accounts receivable of $8,000 (recall that sales of $10,000 were made and $2,000 in cash payments were received), the inventory purchased with the $2,000 loan, and the office supplies, computer, salary, lease, and telephone service paid for with cash.

On the right, or credit, side of the trial balance are Marble’s initial capital investments into Cash, the $10,000 in sales, and the $2,000 borrowed to purchase the inventory.

The adjustments to the trial balance include $54.17 in depreciation on the computer during the first of 36 months of its useful life, and the $166.67 worth of supplies prorated during the first month. The $54.17 in depreciation is found with this formula:

\[ \text{SLN}(B8,0,36) \]

SLN( ) is the Excel function that returns straight-line depreciation. You will learn more about Excel’s depreciation functions in Chapter 16, “Fixed Assets.” This particular entry computes the monthly depreciation on the value in cell B8 ($1,950), assuming that its eventual salvage value will be $0 and that its useful life is 36 months.

TIP

Figure 5.4 shows its six totals with double-underlines. Excel provides a special format for double-underlined totals as well as for single-underlined subtotals. Select the cell or cells whose values you want to underline and choose Format, Cells. (In Excel 12, select the Home tab on the Ribbon, click the Format drop-down in the Cells group, and choose Format Cells from the drop-down menu.) Click the Font tab and select Single Accounting or Double Accounting from the Underline combo box. Choose OK to return to the worksheet.

NOTE

Couldn’t you just divide $1,950 by 36 to get the $54.17 straight-line monthly depreciation? Sure. But by using the SLN( ) function, you make it explicit both that you are calculating depreciation and that you assume 36 months of useful life and a zero salvage value. A year from now, reviewing your income statement, you might appreciate that your calculation was unambiguous.
The value of Office Supplies consumed during the month is $166.67: the value of $2,000 in cell B7 divided by 12.

These adjustments are combined with the trial balance to arrive at the debit amounts in the adjusted trial balance. The worksheet accomplishes this by means of this array formula in cells F4:F18:

\[
=\text{IF(DebitBalance}>=0,\text{DebitBalance},0)
\]

In the formula, DebitBalance is the name of another formula, which is defined as follows:

\[
=(\text{TrialDebits-TrialCredits})+(\text{AdjustDebits-AdjustCredits})
\]

The formula for DebitBalance uses four named ranges (the cell references are to the worksheet shown in Figure 5.4):

- TrialDebits refers to B4:B18, the debit amounts in the trial balance.
- TrialCredits refers to C4:C18, the credit amounts in the trial balance.
- AdjustDebits refers to D4:D18, the debit amounts in the adjustments.
- AdjustCredits refers to E4:E18, the credit amounts in the adjustments.

The steps involved in defining the name DebitBalance are listed here:

1. Choose Insert, Name, Define. (In Excel 12, select the Formulas tab on the Ribbon and then click Name a Range in the Named Cells group.)
2. In the Names in Workbook box, type DebitBalance. (In Excel 12, it's the Name box.)
3. In the Refers To box, type this formula:

\[
=(\text{TrialDebits-TrialCredits})+(\text{AdjustDebits-AdjustCredits})
\]
4. Choose OK (or, if you're ready to define more names, choose Add).

For each of the fourth through eighteenth rows, the formula subtracts any amounts in the Credit column of the trial balance from any amounts in its Debit column. It then adds any adjusting debits and subtracts any adjusting credits. The result is the debit balance—thus the name of the formula.

As noted earlier in this section, DebitBalance is used in this array formula, entered in cells F4:F18 in Figure 5.4:

\[
=\text{IF(DebitBalance}>=0,\text{DebitBalance},0)
\]

To illustrate the array formula’s effect, consider cell F7, the adjusted trial balance for the Office Supplies account. The trial balance provides a debit amount of $2,000 and no credit amount. The adjustments include no debit amount, but a credit amount of 166.67. So the named formula DebitBalance returns (2000-0) + (0-166.67), or 1,833.33. Because that value is greater than zero, the condition in the array formula in cell F7 is satisfied and returns the value 1,833.33.

Before you continue, you might want to be sure that you understand why no nonzero value appears in cells F9:F12.
Cells G4:G18 contain this array formula:

=IF(CreditBalance>=0,CreditBalance,0)

It’s similar to the array formula in cells F4:F18. The sole difference is that it relies on a different named formula, CreditBalance. Using the procedure described earlier to define the DebitBalance formula, CreditBalance is defined as follows:

=(TrialCredits-TrialDebits)+(AdjustCredits-AdjustDebits)

Notice that the formula reverses the relationship between debits and credits used in DebitBalance. Its purpose is to combine trial and adjusting credits and debits so that if credits exceed debits, the formula returns a positive value. Then the array formula in G4:G18 returns values greater than or equal to zero only.

You might have noticed that these various formulas call for Excel to return a zero amount if a condition is not met. For example, the array formulas in F4:F18 and G4:G18 return a DebitBalance or CreditBalance amount when the balances equal or exceed zero, but a zero when they do not. The figure does not show these zero amounts, primarily to avoid visual clutter.

You can suppress the display of any zero amounts in a worksheet by selecting Options from the Tools menu, choosing the View tab, and clearing the Zero Values check box. (In Excel 12, click the Office button and then click Excel Options. In the Display for This Worksheet area, clear the Show a Zero in Cells That Have Zero Value check box.)

Structuring the Income Statement

With the cells in the Adjusted Trial Balance section completed, their revenue and expense information is carried over from the adjusted trial balance to the income statement and balance sheet (see Figure 5.5).

Figure 5.5

Marble Designs’ income statement and balance sheet enable you to determine net income.
For the income statement, information on revenues and expenses is needed. The debit amounts are obtained by means of this formula:

\[ =IF(OR(AccountType="Revenues",AccountType="Expenses"),AdjustedDebits,0) \]

AdjustedDebits, a workbook-level name, refers to the range that occupies cells F4:F18 in Figure 5.4. The range named AccountType occupies cells A4:A18 in Figure 5.5 and contains values that identify the type of account: revenue, expense, asset, or liability. By testing the values in AccountType, the formula can limit the amounts brought into the income statement to debits from Revenue or Expense accounts. Similarly, the credit amounts in the income statement are obtained by means of this formula in cells D4:D18:

\[ =IF(OR(AccountType="Revenues",AccountType="Expenses"),AdjustedCredits,0) \]

The AdjustedCredits range occupies cells G4:G18 in Figure 5.4. Like AdjustedDebits, AdjustedCredits is a workbook-level name.

Two additional amounts are needed to bring the income statement into balance: Ending Inventory and Net Income. Both these amounts are as of the statement date, January 31, 2007.

Ending Inventory is included as a credit amount of $1,500, accounting for the unused remainder of the initial $2,000 purchase.

Net Income is included in the Debit column, as the difference between the income statement’s total Credits and its total Debits. The figure returned is $4,783.17. As a check, notice that this is the result of the following:

\[
\$10,000.00 \text{(Sales)} - \$500.00 \text{(COGS)} - \$4,716.83 \text{(Total Operating Expenses)} = \$4,783.17
\]

Including the Ending Inventory and Net Income brings the income statement into balance.

\[
\text{Recall that COGS equals beginning inventory (here, $0) plus purchases ($2,000) minus ending inventory ($1,500).}
\]

**Structuring the Balance Sheet**

Finally, the Debit and Credit columns of the balance sheet are obtained by formulas similar to those used for the income statement. This formula returns the debit amounts:

\[ =IF(OR(AccountType="Assets",AccountType="Liabilities"),AdjustedDebits,0) \]

This formula returns the credit amounts:

\[ =IF(OR(AccountType="Assets",AccountType="Liabilities"),AdjustedCredits,0) \]

Now Marble is in a position to calculate her working capital. Recall that this is defined as the difference between current assets and current liabilities. As of January 31, 2007, Marble’s current assets are as follows:
Broadening the Definition: Cash vs. Working Capital

$2,554.00 (cash)
$8,000.00 (accounts receivable)
$1,833.33 (office supplies, a prepaid expense)
$1,500.00 (ending inventory)

This adds up to $13,887.33. Marble’s current liabilities include only the $2,000 note payable. Her working capital, therefore, is $11,887.33, or $13,887.33 - $2,000.

Notice that the computer asset is not involved in determining working capital. This is because the computer is not a current asset, one that can quickly be converted to cash in the normal course of business operations.

Determining Changes in Working Capital

From a management perspective, it is important to understand how the amount of working capital changes over time. A comparative balance sheet is useful for this purpose. Figure 5.6 shows an income statement and a balance sheet for Marble Designs, in a somewhat different format than the one used in Figure 5.5.

The balance sheet section of Figure 5.6 lists Marble Designs’ assets and liabilities. On January 1, 2007, when the firm began operation, it had no liabilities and $9,000 in assets, consisting entirely of cash. Its working capital was, therefore, $9,000. By the end of the month, the sum of the firm’s assets was $15,783 (as, of course, was the sum of its liabilities and owner’s equity).

Not all these assets and liabilities are current, however. The current assets as of January 31, 2007, include cash, accounts receivable, inventory, and office supplies, which total $13,887.33. The sole current liability is the note for the purchase of the beginning inventory, for
$2,000. The difference between the total of the current assets and the current liability is $11,887.33, which agrees with the amount arrived at using the information shown in Figure 5.5.

So the change in working capital from the beginning to the end of the month is $11,887.33 - $9,000.00, or $2,887.33.

You can calculate changes in working capital in several different ways. It’s useful to look at them both to understand working capital from different perspectives and because you might want to calculate working capital in the context of different worksheet layouts.

**Using Transactions to Calculate Changes to Working Capital**

Figure 5.7 shows one way to do so, using information about individual transactions.

During January, the sale of products for more than they cost increased working capital: The gross profit was $9,500. Placing $2,000 worth of materials in inventory also increased working capital. These are both current assets, totaling $11,500.

Acquiring a loan of $2,000, the note payable that was used to purchase the inventory, decreased working capital. Working capital was also decreased by the payment of cash for the computer, various operating expenses, and the use of office supplies. These are all current liabilities, totaling $8,612.67.

The net effect of the increase of $11,500 in working capital and the decrease of $8,612.67 in working capital is $2,887.33. During the month of January, Marble Designs increased its working capital by this amount. Note that this is the same figure as was determined by the analysis in Figure 5.6 ($11,887.33 - $9,000).

Normally, you would not determine changes in working capital by examining each transaction that occurred in a given period: There are quicker ways. Also, many transactions occur that affect current assets and current liabilities to the same degree and, therefore, have no net effect on working capital.
For example, when you collect payment for a product or service, this transaction has no effect on working capital. Doing so merely increases one current asset (cash) and decreases another current asset (accounts receivable) by identical amounts. When you write a check for an account payable, you decrease both a current asset account (cash) and a current liability account (accounts payable) by equal amounts. There is no net effect on the amount of working capital.

Therefore, the example shown in Figure 5.7 could have ignored the transaction involved when Marble Designs acquired $2,000 in inventory. This transaction increased a current asset, inventory, and increased a current liability, notes payable, by identical amounts.

In general, transactions that involve only current asset or current liability accounts do have an effect on individual working capital accounts, but they do not have a net effect on the amount of working capital.

**Examining Changes to Current Assets and Liabilities**

Again, working capital is the difference between total current assets and total current liabilities. Similarly, the change in working capital is the combined effect of changes in current liabilities and in current assets. Figure 5.8 shows how you can quickly determine the change in working capital by examining changes to the accounts that make up the current assets and liabilities.

As it happens, the only current asset that declines during January is the Cash account. All other current asset accounts increase in value. One current liability account, Notes Payable, increases by $2,000.00. The change in working capital can then be determined by subtracting the net increase in current liabilities from the net increase in current assets: $4,887.33 - $2,000.00 = $2,887.33.

**Checking the Sources and Uses of Working Capital**

Another means of determining changes in working capital is to compare its sources with its uses. Recall that transactions involving only current asset and current liability accounts
have no net effect on working capital. The same is true of transactions that involve only noncurrent accounts. For example, when Marble records $54.17 as the month’s depreciation on the computer, she adds $54.17 to a noncurrent account, with no net effect on working capital.

However, a transaction that involves a current account and a noncurrent account does affect the amount of working capital. Suppose that Marble invested an additional $1,000 in her business, recording it in both the capital account (noncurrent) and the cash account (a current asset). This transaction would increase working capital by $1,000.

Therefore, when determining changes to working capital, it can be convenient to limit the analysis to transactions that affect only current accounts and noncurrent accounts. Figure 5.9 gives an example.

The sources of working capital, in this case, consist solely of net income. What is depreciation doing there? Recall that depreciation is a noncash expense that, for the purposes of the income statement, acts as an offset to gross profit in the calculation of net income. But no funds change hands as a result of recording depreciation. Therefore, when you use net income to calculate your sources of working capital, it is necessary to add depreciation back—in other words, to reverse the effect of subtracting it in the calculation of net income.

The cash portion of net income, a noncurrent account, is deposited in the cash account, a current asset. Therefore, in combination with the act of adding depreciation back, it can be used to calculate the change in working capital.

The sole use of working capital shown in Figure 5.9 is to purchase the computer. It is also used to determine the change in working capital. Funds from the cash account, a current asset, were used to purchase Equipment, a noncurrent asset.

The difference between the total sources of working capital and the total uses of working capital is, once again, $2,887.33, just as was found by means of the analyses in Figures 5.6–5.8.

### Analyzing Cash Flow

For various reasons, you might want to determine how a company uses its cash assets. The choice to use cash to acquire an asset, to meet a liability, or to retire a debt is a process of
Analyzing Cash Flow

Investment and disinvestment, and a manager always has choices to make, some smart and some maladroit. It’s important to keep track of how well a company’s management is making these choices.

Furthermore, as useful as the accrual method of accounting is in matching revenues with expenses, it tends to obscure how cash flows through a firm. One of the purposes of cash flow analysis is to highlight differences between, say, net income and the actual acquisition of cash. For example, accounts receivable is one component of net income, but it will not show up as cash until the check clears. A company might have a healthy net income, but if its customers do not pay it on a timely basis, it might have difficulty meeting its obligations. Cash flow analysis can illuminate problems, even impending problems such as that one.

To illustrate this process, consider what might transpire in Marble Designs’ financial structure over the period of a year.

**CASE STUDY**

**Marble Designs (Continued)**

During the 12 months following the analyses shown in Figures 5.1–5.9, Marble Designs enjoys successful operations and records the following transactions:

- Makes $90,000 in sales to customers, using $24,500 in inventory to deliver on those sales. As of January 31, 2008, $5,500 remains in accounts receivable, so $84,500 has been received in payment.
- Uses cash to purchase $25,000 in materials to replenish its inventory.
- Collects the $8,000 that remained in accounts receivable at the end of January 2007.
- Pays $53,951 in cash to cover operating expenses.
- Purchases a new computer in July for $2,320 in cash.
- Buys $2,000 in additional office supplies.
- Purchases office space in a new building for $30,000. Before construction of the building is complete, decides against occupying the space and sells it for $35,000, making a $5,000 nonoperating profit.
- Retires the $2,000 note acquired during January 2007 and obtains a new note for $3,000.
- Depreciates the two computers, for a total of $1,037 from January 31, 2007, through January 31, 2008.

Some of these transactions are cash, some are transactions that pertain to normal operations, and some affect current assets and liabilities. Others are noncash, nonoperating, and long term. To determine their effect on Marble Designs’ cash flow, it’s necessary to disaggregate them.

**Note**

This is a relatively simple situation to analyze, and because it is illustrative, it omits many of the transactions that you would normally take into account. For example, it assumes that Marble Designs is an S-corporation and therefore its earnings are taxed on the shareholders’ personal returns.
As a benchmark against which the following analysis will be compared, Figure 5.10 shows the actual cash transactions that occurred as a result of Marble Designs’ activities during the 12-month period.

Developing the Basic Information

Instead of beginning with a checkbook register, start with the standard financial reports: the income statement and balance sheet. Figure 5.11 shows the income statement for the period January 31, 2007, through January 31, 2008, for Marble Designs, as well as a comparative balance sheet showing assets, liabilities, and equity at the beginning and end of that period.
The income statement shows $1,500 worth of materials in inventory at the beginning of the period, an additional $25,000 purchased during the period, and $2,000 remaining at the end. Therefore, $24,500 in materials was used in the completion of $90,000 in sales for the period, resulting in a gross profit of $65,500.

Against that gross profit, various operating expenses were incurred: salaries, the cost of the office lease, and the telephone expense. The $1,833 in office supplies that remained at the end of January 31, 2007, were consumed: This was a prepaid expense because Marble purchased the entire stock of supplies at the beginning of January 2007. Another $2,000 were purchased during the period covered by the income statement.

The depreciation on the computers also appears in the income statement. However, this is a noncash expense. The formula used in cell C18 of Figure 5.11 is as follows

\[ \text{SLN}(1950, 0, 3) + \text{SLN}(2320, 0, 3)/2 \]

This formula uses Excel's straight-line depreciation function, whose arguments are Cost, Salvage Value, and Life. The cost is simply the item's initial cost, its salvage value is the item's value at the end of its useful life (here, Marble estimates that the value will be zero), and its life is the number of periods that will expire before the item reaches its salvage value. The function returns the amount of depreciation that occurs during one period of the item's useful life. So this fragment returns $650, the amount of depreciation in the value of the first computer purchased, during one year of its assumed three-year life:

\[ \text{SLN}(1950, 0, 3) \]

The second computer cost $2,320 and was purchased in July 2007, halfway through the period covered by the income statement. Therefore, the depreciation on that computer during the second half of the year, $386.67, is returned by this fragment:

\[ \text{SLN}(2320, 0, 3)/2 \]

Together, the $650 in depreciation over 12 months for the first computer and the $386.67 in depreciation over six months for the second computer result in a total equipment depreciation of $1,036.67.

It's important to keep in mind that this depreciation does not constitute a cash expense such as a salary check or the payment of a monthly telephone bill. As noted previously, no funds change hands when you record depreciation: It is merely a means of apportioning, or accruing, an earlier use of capital to a period in which the item contributes to the creation of revenue.
Finally, the $5,000 profit from the acquisition (for $30,000) and subsequent sale (for $35,000) of the office space is recorded and added to obtain the total net income. Note that this $5,000 is nonoperating income—that is, it is profit created from an activity, the purchase and sale of property that is not a part of Marble Designs’ normal operations.

The balance sheet repeats from Figure 5.6, in column E, Marble Designs’ assets, liabilities, and equity at the end of January 31, 2007. Column F also shows these figures as of January 31, 2008. The transactions that occurred during the 12-month period resulted in a healthy increase in cash and minor changes to the remaining asset and liability categories. These entries are taken from ledger accounts; the exception is the owner’s equity figure of $27,295.50. The owner’s equity in cell F17 of Figure 5.11 is calculated as follows:

\[ \text{Total Equity} = E17 + C22 \]

That is, this the prior equity figure of $13,783.17 in cell E17, plus the net income of $13,512.33 for the period in cell C22.

**Summarizing the Sources and Uses of Working Capital**

Figure 5.12 shows the changes in working capital that occurred during the year, determined by analyzing the effect of noncurrent accounts. Sources of working capital include operations, the nonoperating profit realized from the purchase and sale of the office space, and a new short-term note.

It can be easy to confuse the concept of working capital itself, the result of subtracting current liabilities from current assets, with an analysis of how working capital is created and used—the subject of the present section. As you work through this analysis, bear in mind that sources and uses of working capital involve noncurrent assets and liabilities.
Note three points about this analysis of sources and uses of working capital:

- You can calculate overall cash flow by determining the net change in the Cash account, but to analyze cash flow, you need to examine all the changes in the balance sheet accounts—including working capital. The details and the overall effect of changes in working capital usually differ from those of cash transactions. Both the working capital and the cash impacts are important in understanding of a company’s financial position.

- Changes in working capital are not the same as changes in cash. In this case, cash increases during the accounting period by $15,229, whereas working capital increases by $12,229.

- The profit on the purchase and sale of the office space appears to have no effect on the increase in working capital. In fact, however, it does: The profit of $5,000 has already been included in net income. Figure 5.12 subtracts that profit from net income to provide a more accurate picture of operations as a source of working capital. Furthermore, the transaction is shown under both sources and uses, to show how capital has been generated and used, not simply to calculate the increase or the decrease over time.

### Identifying Cash Flows Due to Operating Activities

The next step in analyzing cash flows is to focus on cash generated by and used in operations. Figure 5.13 shows this step.

#### Figure 5.13
Determining cash flows from operating activities.

<table>
<thead>
<tr>
<th></th>
<th>TotalCashReceivables</th>
<th>TotalCashPurchases</th>
<th>TotalCashExpenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cash receipts</td>
<td>50,000.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sales</td>
<td>50,000.00</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Accounts Receivable</td>
<td>8,500.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Accounts Receivable</td>
<td>8,500.00</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Change in Accounts Receivable</td>
<td>-2,500.00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Total receivables</td>
<td>92,500.00</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>9</td>
<td>Cash payments</td>
<td>24,000.00</td>
</tr>
<tr>
<td>8</td>
<td>10</td>
<td>Inventory, 1/31/07</td>
<td>1,000.00</td>
</tr>
<tr>
<td>9</td>
<td>11</td>
<td>Inventory, 1/31/07</td>
<td>1,000.00</td>
</tr>
<tr>
<td>10</td>
<td>Change in Inventory</td>
<td>500.00</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Cash payments for purchases</td>
<td>20,000.00</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>Cash provided by operations</td>
<td>35,000.00</td>
</tr>
<tr>
<td>13</td>
<td>14</td>
<td>15</td>
<td>Operating expenses</td>
</tr>
<tr>
<td>14</td>
<td>16</td>
<td>Capitalization</td>
<td>1,036.67</td>
</tr>
<tr>
<td>15</td>
<td>17</td>
<td>Notes Payable, 1/31/07</td>
<td>2,000.00</td>
</tr>
<tr>
<td>16</td>
<td>18</td>
<td>Notes Payable, 1/31/07</td>
<td>2,000.00</td>
</tr>
<tr>
<td>17</td>
<td>19</td>
<td>Change in Notes Payable</td>
<td>1,000.00</td>
</tr>
<tr>
<td>18</td>
<td>20</td>
<td>Cash payments for expenses</td>
<td>54,961.00</td>
</tr>
<tr>
<td>19</td>
<td>21</td>
<td>Cash provided by operations</td>
<td>35,000.00</td>
</tr>
</tbody>
</table>

Generally, three sources or uses of cash arise from operating activities:

- **Cash receipts from customers**—You can easily determine this amount by combining the value for sales (net of any discounts that might have been provided to customers) with changes in accounts receivable. That is, add accounts receivable at the end of the period to the sales figure and then subtract accounts receivable at the beginning of the
The logic is that if accounts receivable has declined during the period, you have collected more in cash than you have accrued in accounts receivable; if it has increased, you have accrued more in receivables than you have collected in cash.

- **Cash outlays for purchases**—From the standpoint of operating activities, there is one use of cash for purchases: inventory. Therefore, to summarize cash flow for operating purchases, add to the cost of goods sold during the period of the ending inventory level, and subtract the beginning inventory level.

  Additionally, you might have purchased inventory with a note or account payable to the suppliers of your inventory materials. In this case, you add any decrease in these payables (because you used cash to decrease them) or subtract any increase in these payables (because you used credit, not cash, to acquire the materials).

- **Cash outlays for expenses**—These are available from the operating expenses portion of the income statement. Combine the total operating expenses with any changes in prepayments and accrued liabilities, such as employee salaries earned but as yet unpaid, at the end of the period.

In the case of Marble Designs, applying these calculations as shown in Figure 5.13 indicates that sales, increased by a reduction of $2,500 in accounts receivable, results in cash receipts of $92,500. Cost of goods sold, increased by the $500 change in inventory level, results in $25,000 in cash purchases. Total operating expenses also were (a) reduced by $1,036.67 in depreciation, a noncash, long-term prepayment, and (b) increased by a change in the amount of notes payable, converted to cash and used to acquire office supplies.

Subtracting cash payments for purchases and for expenses from total receipts results in $12,549.00, the amount of cash provided by operations.

This completes the process of converting information contained in the income statement, receipts, and outlays represented as accruals into a cash basis, represented as actual cash receipts and outlays occurring during the period in question.

**Combining Cash from Operations with Cash from Nonoperating Transactions**

The final step in developing the cash flow analysis is to combine the cash amounts used for normal operations with the cash transactions that apply to nonoperating activities. Figure 5.14 provides this summary.
Cash receipts, in this case, consist of cash from operations and cash received from selling the office space. Cash outlays consist of the purchase of the new computer and the office space. The difference between the two, $15,229, represents the amount of cash Marble Designs generated during the 12-month period, and this figure should agree with the difference in the cash account between January 31, 2007, and January 31, 2008. Refer back to Figure 5.10: The difference between the ending balance of $17,783 and the beginning balance of $2,554 is $15,229, which agrees with the results of the cash flow analysis.

In reality, cash flow analysis is a much more complicated task than the relatively simple example provided here. It includes many more transactions than were included in this example: The effect of taxes must be taken into account, accrued liabilities complicate the process, and such transactions as the issuance of stock, dividends, and long-term bonds affect the identification and calculation of cash flows. However, the example illustrates the basic principles and overall process of converting balance sheets and income statements into information about how a company creates and uses its cash resources.

Summary

In this chapter, you saw how to analyze working capital, learned about its sources and uses, and saw how to move beyond the information in the balance sheet and income statement. Working capital is an important gauge of a company’s financial health, and it can be hidden by the accrual basis used by other analyses.

This chapter also described how to analyze the flow of cash into, through, and out of a company as a result of its transactions. Because cash is the most liquid form of working capital, it is an important component of many financial ratios used by investors and potential creditors; you will learn more about these in Chapter 7, “Ratio Analysis.” Cash flow analysis is also an important means of understanding the difference between such items as net income and actual receipts.

Furthermore, the ways that a company uses its working capital and, in particular, its cash are a good indicator of how well it manages its assets overall. This highlights and summarizes the investments and disinvestments the company’s management makes every day. Highlighted, those choices can give you insight into the way management handles its responsibilities. People who know how to create these analyses stand a much better chance of protecting their investments before management folds the company’s tents.